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Title Bar
The title bar is located along the top of a window.    It contains the name of the application 

and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars
Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.

<< Describe the actions of the various parts of the scrollbar, according to how they behave 
in your application. >>



Size command (System menu)
Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)
Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)
Use this command to reduce the Instant ReportCard window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)
Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command
Use this command to switch to the next open document window.    Instant ReportCard 
determines which window is next according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Previous Window command (document Control menu)
Use this command to switch to the previous open document window.    Instant ReportCard 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: CTRL+F6



Close command (Control menus)
Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)
Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)
Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Instant ReportCard implements this command only through its shortcut.    It is not available 
on any menu.    You can also switch to a particular window directly by selecting it from the 
Windows menu.



Overview
This is what Instant ReportCard does for You:

it creates report cards from a database of comments according to your instructions
it automatically personalizes the comments using the student's name and gender
it lets you edit the completed report card using a built-in a word processor
it prints report cards for all students of a class or for only one or more selected 

students.
it allows you to build and organize your own database of comments

How does it work?



How does it work?
Instant ReportCard is built on the concept of a library of comments. To write a report card, 
you simply select the comments from the library and Instant ReportCard will put the full text 
for that comment into the report card. To make it as close to a handwritten comment as 
possible, the comments in the library can contain placeholders for details that depend on 
the student to which the comment applies: its first name, personal pronouns in the subject 
and object form and possessive pronouns. These placeholder get automatically resolved by 
Instant ReportCard when the comment is used, including correct gender and capitalization 
after a period.
The comments in the library are organized by categories. The categories do not have to be 
teaching subjects, they can be anything you like to organize the comments. For example
teaching subjects: General Comments, Language Arts, Math, 
grades: Universal, Grade 3, Grade 4, Grade 5, 
teachers : Mrs A, Mr B, 
or, if you dont like the idea, put all comments into one ategory. But you need at least one 
category, because in Instant ReportCard every comment must be associated with a 
category. 

    A caution though: Instant ReportCard has not been optimized to handle large 
numbers (i.e. hundreds) of comments in a single category.

Where do you get that library of comments?



Where do you get that library of comments?
Firstly, Instant ReportCard comes with a comment library containing over 400 comments. 
Secondly, and more importantly, you can create your own libraries (or copy some from a 
collegue if s/he has Instant ReportCard as well). Instant ReportCard contains all necessary 
means to create and maintain comment libraries. You can have several of them. To your PC, 
these libraries are just ordinary files. You also can easily mix comments from several libraries
in one report card: just close the current library and open a different one.
When writing report cards, you are never limited to the comments stored in the libraries. At 
any time you can go directly into the report card and edit the comments that you have 
selected, or add spontaneous comments.

The format of the reportcard files



The format of the reportcard files
A report card file created and saved with Instant ReportCard in text format can be opened by
any text editor or wordprocessor as a plain text file.
You may want to modify the file with a different program, e.g. by using a spelling checker. If 
you obey the following rules, Instant ReportCard can still open the modified file and retrieve 
the student data and the text of the comments.

the file must be saved as a plain text file. All wordprocessors have this option.
Instant ReportCard imbeds the student data in the text. This student data must not 

be altered.
This is how an Instant ReportCard file looks when opened as a text file:
The string TEXTiRCd indicates that this files has originally been created by Instant 
ReportCard. It must remain as is at the beginning of the file.
The text between the ÇÇÊ and the ÊÈÈ are the student data last name, first name, middle 
initial or names (optional), gender (f or m) and a common or informal name (also optional), 
separated by tabs. This entire line, including the new-line characters at the beginning and 
end of it, must not be altered. Otherwise Instant ReportCard will not be able to rebuild the 
class roster and each students comments. There is one such line, enclosed by    ÇÇÊ and 
ÊÈÈ, for each student in the class roster. The text following each such line are the comments
for this student.

Can you not do all that with a wordprocessor program?
Maybe, but not easily. How would you do it? Glossaries give you the flexibility of different 
comments, but are not personalizable to the current student. Mail merge does give you the 
personalizability, but not the flexibility of different texts for each students since it is 
designed to produce the same form letter for every person in the database.



No Help Available
No help is available for this area of the window.



No Help Available
No help is available for this message box.



TEXTiRCd
ÇÇÊDoe John John James m JohnnyÊÈÈ
This has been a very satisfactory term for John . He tackled all oral and written assignments 
and worked confidently and steadily. ...



This is sometimes also referred to as an ASCII file.



he or she



him or her



his or her



Think of it as books on a bookshelf. The comments are the books, the categories are the 
shelves. You need at least one shelf to hold the books. Multiple categories ( shelves ) help 
you to better organize your comments ( books ).



Sometimes students use a short form of their formal first name, or an entirely different 
name. You can make the report card more personal by using the formal first name only in 
the header, but the informal, every-day name in the comment text.





Creating Report Cards
The next couple of topics lead you through the typical steps in creating report cards using 
Instant ReportCard. The topics are linked in a browse sequence. You get to the next topic in 
sequence by clicking on the  button.
It assumes that you are familiar with the basic operations of Windows: dragging, clicking, 
double-clicking, what and where the ctrl and alt keys are, how to select from a menu, how to
open and save a file, and so on.
Double-click on the Instant ReportCard icon. 
A new, empty report cards file opens named "Untitled1":
The field in the toolbar with the black triangle is a drop-down menu that gives you access to 
the report card for each student in the file. Right now it is still empty. The class roster button 
to the right of it gives you access to the class roster.
You can not write report cards without having students. The first thing you need to do is to 
enter the class roster. Click on the class roster button or select "Class Roster" from the "Edit"
menu.
A window with a title of Students in Class "Untitled1" opens:
This is where you maintain the roster of students in the report cards file: add or remove 
students or change the data about them.

 The one file holds the report cards for all students in the roster.



Building the Class Roster
The next thing to do is to enter the student information:

type Doe for the last name,
jump to the firstname field by pressing the tab key,
type John and press the tab key,
type Johnny for a common and press the tab key again,
type James for a middle name and press the tab key again,
click on the male gender radio button.

Now click on the Add button, or simply press the enter key. The name Doe, John appears in 
the class list. The fields that you have typed into have been cleared and everything is ready 
for the next student.
Type Doe, tab, Jane, tab, tab, Mary, click on the female gender radio button and press 
enter. This time we did not enter a common name. A common name is optional. If none is 
given, the program automatically uses the first name instead.
The name Doe, Jane appears ahead of Doe, John in the class list. This is because Instant 
ReportCard automatically sorts the class list in alphabetical order.
Let us enter one more student for now: Doe, tab, Richard, press Alt-m and enter. This time 
we did not enter a common name nor a middle initial for Richard. Middle names or initials 
are also entirely optional.
Three students is enough for this exercise. Click on OK or in the close box to close the dialog.



Saving the ReportCard file

 It is a good idea to save your work after you entered the class roster.
Select Save As from the File menu.
The standard windows file save dialog opens and suggests a file name of "untitled.irc". 
Change the filename to tutorial, but leave the extension .irc, then click on Ok. The file 
tutorial.irc now contains the report cards for all three of our students (albeit all still empty). If
your real class has e.g. 28 students, the (one) Instant ReportCard file will contain the report 
cards for all 28 students.



Instant ReportCard file formats
Instant ReportCard supports two file formats:

an internal format with extension .irc that is only understood by Windows Instant 
ReportCard itself

a text format with extension .txt. A reportcard file that has been saved in text format
can be opened by any word processor program ( to do spell checking for example) or can be 
transferred to a Macintosh and opened by Instant ReportCard for Macintosh .

 The extension of a file does not determine the file format. It is merely a convention that 
should be followed. When saving a file for the first time, you must select the desired format 
from the file type list in the file save dialog.
When opening a file, Instant ReportCard recognizes the format automatically, regardless of 
the extension. Saving a file whose format has been established (either by having selected 
the format from the file type list, or by having opened an existing file) will always use the 
current format. To change the format, you have to use the command Save As.. from the file 
menu.



Opening a Comment Library
Now we need to open a comment library. Select Open Library from the Comments menu. 
Find and open the file COMMENTS.IRL that came with the Instant ReportCard program.
A list appears on the left side of the Instant ReportCard window. The empty window with the 
title of the reportcard file that we just created ( tutorial.irc ) is moved to the right to make 
room for it. 
On the top of the list is a drop down listbox which lets you select the different categories of 
comments that are contained in the library. Currently the comments in category Personal 
Development are selected. The list below this drop down listbox contains the descriptors of
all comments in this category.

 Tip - You can use the name of the currently selected category as a chapter heading in the 
students' reportcards by clicking on the chapter-heading   button   in the toolbar or using the 
keyboard shortcut Ctrl-D. You have to do this for each student separately.

 Tip - If you want a printout of some, or all, comments in a library, there are two ways:
1 - You can create a fictitious class with a few "students", best is one per category with a 

"name" equal to the category; set the comment placement to leave a blank line between
comments and double click on every descriptor, thus using every comment in this 
"report card". Then print it. The drawback of this method is that you only get the 
comments, not the descriptors.

2 - You can order Comment Browser which was written for this exact purpose. It allows you 
to view and print the content of a comment library. See the readme.txt file for price and 
ordering information.



 



Comment Configuration
There are some controls that let you manipulate the way in which comments that you select 
from the library show up in the students' report cards. Before we actually use the comments 
from the library, I want to introduce these controls.

the toolbar contains two groups of push buttons that control some aspects of putting 
comments from a library into a student's report card:
One button in each group is always selected, indicated by appearing to be pushed in.
The left group lets you select where, in relation to the previous comment, the next comment 
should be placed; See the toolbar topic for an explanation of the meaning of the 
pushbuttons.
Click on the leftmost button of this group to select adjacent placement of comments.
The group on the right lets you decide what subject you want to use for comments with a 
subjectless comment. See the toolbar topic for an explanation of the meaning of the 
pushbuttons.
Click on the rightmost button of this group, the dice, to select the random choice for 
sentence subject. 

 The setting of these controls is automatically saved in the configuration file when you 
terminate Instant ReportCard, and restored to the last setting when you start the program.



"Writing" Comments
You are now ready to begin placing comments into the report cards. Double-Click on 
"cheerful and courteous" in the list of descriptors. The full text of the associated 
comment
"Jane is a cheerful and courteous student in class with peers and teachers."
is placed in the report card (your comment may read "She is ..." because of the random 
selection).
Let's put a few more comments into this paragraph. Not that the resulting paragraph will 
make a whole lot of sense, just to show how it works. Double click on "eager to learn". The 
comment is put adjacent to the first comment because we had requested adjacent 
placement of the comments with the pushbutton in the toolbar.
Click on the arrow to the right of Personal Development and select Language Learning 
from the drop down list. The list of descriptors changes because the descriptors are now 
those for the comments for Language Learning. Double-click on enjoys stories.
It is time to save what you have done so far. Select Save from the File menu.

 A note regarding saving files. 



Navigating the class roster
Let us leave Jane Doe for now and turn to John Doe. Click on the arrow in the drop-down box 
in the toolbar
A menu pops up with the names of all students in the class roster. Select Doe, John from the 
list. The name that is displayed changes to Doe, John and the lower part of the window, 
which contained the text of Jane's report card, is now blank, just as it was for Jane at the 
beginning.
Don't worry. All that text is still there. It is just not shown. Only one student's report card is 
displayed at a time. Click to pop up the list and select Doe, Jane. The name changes back to 
Jane and the comments are back too. Click again and re-select John.
Now go ahead and put in some comments for John, just as you did for Jane. Then do the 
same for our third student, Richard.
When you are done, save the report cards file
Note that you can also navigate through the list of students using just the keyboard: hold 
down the ALT key and press the Home or End key to move to the first and last student in the 
class list respectively. Press the Page-up or Page-down key (while holding down the ALT key) 
to move forward or backward through the lsit of students.



Safe Saving
Instant ReportCard uses a "safe saving" technique. When you select Save from the file 
menu, Instant ReportCard does not write the new contents over the original file. Doing so 
could risk loosing everything: if something should happen while the new content is written, 
the new file is not completely written yet and therefore most likely unusable, but the old one
is already destroyed. The "safe saving" technique avoids that by employing a temporary file.
The new content is first written to a temporary file, leaving the real file untouched. After the 
temporary file has been successfully written, it is then copied over the original. Once that is 
complete, the temporary file is reset to empty. Now if something happens during the save 
there is always a good copy of either the old file, or the new one.
Ordinarily, you can just forget about all this. So why am I telling you? Because there are 
circumstances where knowing it can be useful, if not important. For example, you may 
receive an error message that there is not enough room on the disk to save the file, but 
when you check. there seems to be plenty. Firstly, there obviously must be enough disk 
space for two times the file since the entire file is temporarily also stored in the temporary 
file. Or it is actually during saving to the temporary file that the space shortage occurs, while
the disk where the real file resides has enough space. So where is that temporary file 
stored? If you haven't made special arrangements, in the windows directory. If there was an 
error, Instant ReportCard subsequently will tell you the name and location of the temporary 
file. If there was a complete crash, you can check the section [Temp] of the configuration 
file. It contains a list of files that were open when the program (or windows) crashed and 
their associated temporary files. When a file is closed, its entry is removed from the list, and 
when Instant ReportCard terminates, the entire section is deleted.



You can create a special directory for temporary files - Instant ReportCard isn't the only 
program that uses them - and tell windows by setting the temp environament variable.
e.g. create a directory temp right on your C drive and add the following line to your 
autoexec.bat file:
SET TEMP=C:\TEMP
Having a special directory has the advantage that it is easy to monitor. Normally, it should 
always be empty.



or press Alt-m, i.e. press the m key while holding down the Alt key



or press Alt-f, i.e. press the f key while holding down the Alt key









Make sure that no character translation is done during the transfer except for converting the
carriage-return line-feed combination, which indicates a new line on PCs, to just carriage-
return, the Macintosh's indication for a new line.



To open reportcard files saved by Instant ReportCard for Windows in text format requires 
version 1.5 or later of Instant ReportCard for Macintosh.
Instant ReportCard for Windows can open reportcard files created by Instant ReportCard for 
Macintosh version 1.3 or later.





Part of the window may disappear "behind" the right edge of the surrounding frame. If that 
happens, you can bring all of the window back inside the frame by selecting tile or cascade
from the Window menu



A comment descriptor is a mnemonic that lets you identifiy, and therefore find and select, a 
particular comment in a list of other descriptors. For the comments provided with Instant 
ReportCard, I have tried to use catchwords from the comments as descriptors. When you 
create your own libraries of comments, you can use as descriptors whatever works for you: 
words, numbers, symbols



The file rptcard.ini in the windows directory



Printing Report Cards
Many schools use forms for printing report cards. The forms generally consist of two areas: a header 
portion for the students name, the school name, date or term, etc. And a portion for the text of the report 
card. With the Page Setup dialog (accessible from the ReportCard menu) you tell Instant ReportCard 
where on the page these two areas are located.

With Instant ReportCard, you build the text portion of the report cards. But what about the header? Instant
ReportCard automatically prints the student's name in the header area. You can choose from four 
different formats using the Preferences dialog.

Before printing the report cards, you may want to Preview how the printed pages look.

Select Print from the File menu. The Print Dialog allows you to select whether you want to print the report 
cards of all students or just individual ones. Beyond that, you can not select just individual pages out ofa 
student's report card. The entire report card(s) of all selected students are printed.

To select individual students, first choose Select instead of All, then select students by clicking on their 
name. Students whose name is selected (highlighted) are printed. Simply clicking on an unselected name
selects it and unselects any existing selection(s). Holding down the CTRL key while clicking on a name 
reverses that selection - selects if it was not selected, unselects if it was - without affecting any other 
selections. Holding down the shift key while clicking on a (unselected) name selects all names between it 
and a previously selected name.



Print Preview
Select Print Preview from the File menu. 



Creating a new Comment Library
Select New Library... from the Comments menu. 
An empty list appears on the left side of the Instant ReportCard window. If a reportcard 
window is open, it is moved to the right to make room for the list. 
On the top of the list is a drop down listbox which lets you select the different categories of 
comments that are contained in a comment library. Because this is a brand new library, it is 
empty.



Adding Categories to the Library
Select Edit Categories... from the Comments menu.
Instant ReportCard displays a dialog with a title of Categories from Library1.
Type Attendance and press the enter key or click on the Add button. Then type Language 
Arts and press enter again. You now have two categories in this new library. For your own 
library youll probably create a couple more. You don't necessarily have to create all 
categories at once. You can always come back and add - or delete - categories.
Click on OK. This closes the dialog.



Adding Comments to the Library
Select Edit Comments... from the Comments menu.
Instant ReportCard displays a dialog with a title of Comments from Library1.
The category combo box is the only one not empty. It reads Attendance. Click on the arrow,
or anywhere in the field. A list opens containing all the categories in this library - here the 
only other one is Language Arts.
We will use it later when we want to enter comments for another category. Any comments 
you enter get catalogued under the category shown in the combo box, so make sure the 
right category is selected before entering comments.



Creating a Comment - Descriptor
Lets assume you want to store the comment
Name    has to this date enjoyed perfect attendance
in the library. For Name    of course we want to use the students common name.
The first thing you need to do is think of a descriptor, a mnemonic that lets you find this 
comment in a list with other descriptors, other mnemonics.
Type perfect as descriptor for this comment into the field at the top right; the insertion 
point is already positioned there (in case it is not, click in the field to move it there).

 Tip - When you create your own comments, you can use descriptors that are in sync with 
the way you keep track of your students' performance. Perhaps a numbering scheme, e.g. 1 
through 10 or 100%, 80%, ..., or descriptors reminiscent of grades (A, B+, ...). And the 
associated comments reflect the gradation that is implied by the descriptors, of course 
Then, at report card time, you just need to pick the comment(s) that reflect the student's 
current level in accordance with your notes.
Press tab to move the insertion point to the next field.



Creating a Comment - General Rules
This is where you type the actual comment. You can write comments that are longer than 
the field, a scrollbar appears when that happens. When you write your comment, you should
not press enter or return at the end of the line like you would with a typewriter. They 
activate the default button, in this case Add causing your incomplete comment to be stored 
in the library. This wouldnt be the end of the world since you can edit the comment and 
complete it.
Dont pay any attention to the lines at all. How the text wraps here has nothing to do with 
how it wraps when you put the comment into a report card. A report card is wider and 
therefore more text fits into a line before it has to begin a new line.

 If you want to make sure that something (a new sentence for example) starts on a new line,
you can do that by holding down the SHIFT key while you press the enter or return key.



The descriptor is used to identify a comment within the list of comments for a category. For 
your own comments, you can use whatever you like as a descriptor: key words from the 
comment, or number them sequentially, or grade marks (A, B+, ...), or percentages (100%, 
90%, ...).



Creating a Comment - the name placeholder
If you would just type
Name has to this date enjoyed perfect attendance.
this is exactly what would be written into a report card when you select this comment. We 
want Name to be replaced by the students common name however. Somehow you have to 
let Instant ReportCard know that. The way you do that is to use a special symbol as a 
placeholder.
That symbol is &0. As a little help, Instant ReportCard provides a shortcut for the name 
symbol &0: hold down the Ctrl key and type 0 (zero).
Whenever Instant ReportCard detects this combination, it will replace it with the students 
common nameROSTRDLG_COMMONNAME when writing the comment into the report card. 
So, type
&0 has to this date enjoyed perfect attendance.
Dont forget the period at the end.Then press enter, or click on the Add button. The comment
descriptor perfect appears in the comment list, the two entry fields are cleared and the 
insertion point returns to the comment descriptor field.



Creating a Comment - placeholders for he/she, his/her
The next comment we want to write is
She    has now missed so many days that her    completion of this years work is in 
doubt.
Again you let Instant ReportCard know about the pronouns by using special symbols:
&1 for he/she &2 for his/her
This is therefore what you write:
"missed many days" as comment descriptor, then tab forward and type
&1 has now missed so many days that &2 completion of this years work is in 
doubt.
The same shortcut for the special symbols works here: you can hold down the Ctrl key and 
type 1 and 2 respectively.
Press enter to add the comment to the library.



 Instant ReportCard automatically capitalizes personal pronouns after a period or a new line 
in the report card.



Creating a Comment - placeholder for him/her
The next comment is for our other category: Language Arts. Click on the arrow of the combo 
box (or in the field itself) and select Language Arts. The category combo box shows now 
Language Arts as current category.
There is a third kind of pronoun that requires personalization: him/her, as in
He    expresses himself well but needs to project his    voice more to be heard in a 
large group setting.
The special symbol for him/her is &3.
Give the comment a descriptor of expresses self well and type
&1 expresses &3self well but needs to project &2 voice more to be heard in a 
large group setting.
Again you can produce &3 by holding down the Ctrl key and typing 3.

 This example also shows that the special symbols do not have to stand by themselves to be
recognized. Here we combined &3 with self, which will becomes herself/himself. Another use 
of this capability is in &0s which becomes e.g. Janes or Johns. With this use, however, you 
have to watch out when a students common name ends with an s, e.g. Andreas, because 
Instant ReportCard will in this case write Andreass which of course is not correct. Youll have 
to correct that in the report card.
Press enter to add the comment to the library.



Creating a Comment - subjectless comment
There is one more special feature that was mentioned in the tutorial on how to use Instant 
ReportCard to write report cards: subjectless comments.
Comments often come in two almost identical forms: Name has  and He/She has  and I 
said that you can write comments in such a way that the decision which form to use is 
delayed until you actually select the comment. This is how you do it: omit the &0 or &1 and 
begin the comment with the blank, i.e. instead of
&0 is progressing well with &2 language arts.
you write
 is progressing well with &2 language arts.
The space at the beginning is important! Without the blank at the beginning only the normal
replacement of the special symbols is done. This also means that you can have this delayed 
choice only at the beginning of the comment, not for a sentence later in the comment.
That is all there is to writing your own comments. Click on OK.    You can now use these 
comments in reportcards.



or select close from the system menu or use the ALT-F4 shortcut



 When you delete a category, all comments in that category are deleted as well.



or use the toolbar shortcut: 



or use the toolbar shortcut: 





File menu commands
The File menu offers the following commands:

New Creates a new report card.
Open Opens an existing report card.
Close Closes an opened report card.
Save Saves an opened report card using the same file name.
Save As Saves an opened report card to a specified file name.
Check 
Spelling

Checks the spelling of all report cards in this file.

You must have acquired the spelling checker add-on for this 
menu option to appear and be available.

Print Prints a report card.
Print Preview Displays the report card on the screen as it would appear 

printed.
Print Setup Selects a printer and printer connection.
Exit Exits Instant ReportCard.



Edit menu commands
The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the report card and moves it to the clipboard.
Copy Copies data from the report card to the clipboard.
Paste Pastes data from the clipboard into the report card.
Select All Select all text in the current student's report card.
Class Roster Add, delete or edit students to the active report card document.
Preferences Customize some aspects of Instant ReportCard



Comments menu commands
The Comments menu offers the following commands:

New Library Creates a new comment library.
Open Library Opens an existing comment library.
Close Library Closes the currently opened comment library.
Save Library Saves the currently opened comment library using the same file 

name.
Save Library 
AS

Saves the currently opened comment library using the same file 
name.

Edit 
Categories

Add, modify, or delete comment categories in the library.

Edit 
Comments

Add, modify, or delete comments in the library.

Reportcard menu commands
The Reportcard menu offers the following commands:

Page Setup Set the position and margins of the report card page body and 
header.

Set Font Choose the font and font size for the report card.
Check 
Spelling

Checks the spelling of the report card of the currently shown 
student.
You must have acquired the spelling checker add-on for this menu 
option to appear and be available.



View menu commands
The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Comment List Shows or hides the comment list 
First Student Displays the report card for the first student in the class 

roster.
Last Student Displays the report card for the last student in the class 

roster.
Next Student Displays the report card for the next student in the class 

roster. 
Previous 
Student

Displays the report card for the previous student in the 
class roster.



Window menu commands
The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple report cards in the application window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 
2, ...

Goes to specified window.



Help menu commands
The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)
Use this command to create a new report card in Instant ReportCard.

You can open an existing report card with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)
Use this command to open an existing report card in a new window.    You can open multiple 
report cards at once.    Use the Window menu to switch among the multiple open report 
cards .    See Window 1, 2, ... command.

You can create new report cards with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box
The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:

Instant ReportCard native file format - extension .irc.
Instant ReportCard text file format - extension .txt. This format can be used to 
exchange files with Instant ReportCard for Macintosh or to import the file into a word 
processor.

Drives
Select the drive in which Instant ReportCard stores the file that you want to open. 

Directories
Select the directory in which Instant ReportCard stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)
Use this command to close the window containing the active report card.    Instant 
ReportCard suggests that you save changes to your report card before you close it.    If you 
close a report card without saving, you lose all changes made since the last time you saved 
it.    Before closing an untitled report card, Instant ReportCard displays the Save As dialog 
box and suggests that you name and save the report card.

You can also close a report card by using the Close icon on the report card's window, as 
shown below:



Save command (File menu)
Use this command to save the active report card to its current name and directory.    When 
you save a report card for the first time, Instant ReportCard displays the Save As dialog box 
so you can name your report card.    If you want to change the name and directory of an 
existing report card before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)
Use this command to save and name the active report card or change the file format.    
Instant ReportCard displays the Save As dialog box so you can name your report card and 
select type and directory.    

To save a report card with its existing name, type and directory, use the Save command.



File Save As dialog box
The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a report card with a different name.    A filename can contain
up to eight characters and an extension of up to three characters.    Instant ReportCard 
adds the extension you specify in the Save File As Type box.

File Type
Instant ReportCard supports two file formats:

extension .irc an internal format that is only understood by Instant ReportCard for 
Windows itself

extension .txt a text format. A ReportCard file that has been saved in text format can 
be opened by any word processor program ( to do spell checking for example) or 
can be transferred to a Macintosh and opened by Instant ReportCard for Macintosh .

Drives
Select the drive in which you want to store the report card.

Directories
Select the directory in which you want to store the report card.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Check Spelling command (File menu)
Use this command to check the spelling of every report card in this file. To check the spelling
of just the report card of the currently shown student, use the Check Spelling command from
the ReportCard menu.



1, 2, 3, 4 command (File menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last four 
report cards you closed.    Choose the number that corresponds with the report card you 
want to open.



Exit command (File menu)
Use this command to end your Instant ReportCard session.    You can also use the Close 
command on the application Control menu.    Instant ReportCard prompts you to save report 
cards with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)
Use this command to reverse the last editing action, if possible.      The name of the 
command changes, depending on what the last action was.    The Undo command changes to
Can't Undo on the menu, or is disabled (grayed), if you cannot reverse your last action.

Shortcuts
Keys: CTRL+Z or

ALT-BACKSPACE



Cut command (Edit menu)
Use this command to remove the currently selected data from the report card and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+X



Copy command (Edit menu)
Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+C



Paste command (Edit menu)
Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts
Keys: CTRL+V



Select All (Edit menu)
Use this command to select all text in the currently active window.    In other words, the 
entire text of the report card of the current student.

Shortcuts
Keys: CTRL+A



Edit Class Roster (Edit menu)
Use this command to start the class roster dialog for adding, deleting or changing the names
of the students in the currently active report card file. It is disabled if there is no report card 
file open.

Shortcuts

Toolbar:



Edit Preferences
Use this command to start the preferences dialog for selecting the type of print header for 
the report cards and setting the odds for the random selection of the subject of a subjectless
comment



Subjectless Comment
Comments often come in two almost identical forms: "Name has ..." and ..."He/She has ..." 
where the only difference is the form of the subject of the sentence: first name or personal 
pronoun. Instant ReportCard allows comments to be written such that the sentence subject 
remains undecided until the comment is put into a report card, allowing the same comment 
to be used either way. 



New Library command (Comments menu)
Use this command to create a new comment library in Instant ReportCard.

You can open an existing comment library with the Open Library command.



Open Library command (Comments menu)
Use this command to open an existing comment library.

You can create a new comment library with the New Library command.



You can have only one comment library open at a time.    If a comment library is already 
open, this command will be grayed and disabled.



Close Library command (Comments menu)
Use this command to close the active comment library.    Instant ReportCard suggests that 
you save changes to your comment library before you close it.    If you close a comment 
library without saving, you lose all changes made since the last time you saved it.    Before 
closing an untitled comment library, Instant ReportCard displays the Save As dialog box and 
suggests that you name and save the comment library.



Save Library command (Comments menu)
Use this command to save the active comment library to its current name and directory.    
When you save a comment library for the first time, Instant ReportCard displays the Save As 
dialog box so you can name your comment library.    If you want to change the name and 
directory of an existing comment library before you save it, choose the Save As command.



Library Save As command (Comments menu)
Use this command to save and name the active comment library.    Instant ReportCard 
displays the Save As dialog box so you can name your comment library.    

To save a comment library with its existing name and directory, use the Save command.



Edit Categories (Comments menu)
Use this command to start the edit categories dialog for adding, deleting or changing the 
names of the comment categories in the currently open comment library. It is disabled if 
there is no comment library open.

Shortcuts

Toolbar:



Edit Comments (Comments menu)
Use this command to start the edit comments dialog for adding, deleting or changing the 
descriptors and/or the text of comments in the currently open comment library. It is disabled 
if there is no comment library open.

Shortcuts

Toolbar:



Page Setup (ReportCard menu)
Use this command to start the Page Setup dialog to set the location and size of the header 
and body areas for the report card.



Set Font (ReportCard menu)
Use this command to select the font and font size for the report card. All text of the report 
cards of all students in the active document will change to the chosen font and/or size.



Check Spelling (ReportCard menu)
Use this command to check the spelling of the report card of the currently shown student. To
check the spelling of every report card in this file, use the Check Spelling command from the
File menu.



Toolbar command (View menu)
Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Instant ReportCard, such as File Open.    A check mark appears 
next to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in Instant ReportCard,

To hide or display the Toolbar, choose Toolbar from the View menu (Alt, v, t).

Click To

Open a new report card.

Open an existing report card.    Instant ReportCard displays the Open dialog box, in 
which you can locate and open the desired file.

Save the active report card with its current name.    If you have not named the report 
card, Instant ReportCard displays the Save As dialog box.

Print the active report card.

Next is a drop down list box which gives you access to the individual students in the current 
document.

Edit the class roster.

Edit the subject categories in the comment library.

Edit the comments in the comment library.

Insert the name of the currently selected category as a heading for the next block of 
comments. Shortcut key: Ctrl-D

The next six buttons do not perform an action when clicked, but rather show the choice of a 
setting that affects how selected comments are processed. One, and only one, in each group
of three buttons is always pushed, or in other words, selected

Append the next comment to the previous one, just leaving a space.

Start the next comment in a new line.

Leave a blank line before starting the next comment.

Use the student's name to complete a subjectless comment.

Use the personal pronoun to complete a subjectless comment.

Choose at random between name and pronoun to complete a subjectless comment.



Status Bar command (View menu)
Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Instant ReportCard window.    To display or 
hide the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Comment List command (View menu)
Use this command to display and hide the list of comment descriptors, from which you 
select corresponding comment by double-clicking on the descriptor. A check mark appears 
next to the menu item when the Status Bar is displayed. This command is only enabled if a 
comment library is open.



Cascade command (Window menu)
Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)
Use this command to arrange multiple opened windows in a non-overlapped fashion.



Arrange Icons command (Window menu)
Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window menu)
Instant ReportCard displays a list of currently open document windows at the bottom of the 
Window menu.    A check mark appears in front of the document name of the active window.  
Choose a document from this list to make its window active.    



Index command (Help menu)
Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Instant ReportCard and various types of reference
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)
Use this command for instructions about using Help.



About Instant ReportCard command (Help menu)
Use this command to display the copyright notice and version number of your copy of 
Instant ReportCard.





The Class Roster Dialog
The Class Roster dialog is the place where you input and maintain the student data for the 
report card file. It consists of five input fields, two output or feedback fields, a list and five 
command buttons. Click on each field for information about its use.



Enter here the student's last name. The last name is required.



Enter here the student's first name. The first name is required.



This is an optional field. Enter here, if you wish, a common name for the student if the name 
used to address the student in class is either different from his/her first name, or is a 
commonly used derivation of the first name, e.g. Johnny for John. This allows you to make 
the reportcard more personal since the common name is used to personalize the comments 
while the first name is used in the printed header.
If no common name is entered, the first name is automatically used.



This is an optional field. Enter here, if you wish, middle name(s) or initials. These are only 
used in the printed header if the appropriate type is selected in the preferences dialog.



Click on the appropriate radio button to set the gender of the student. The gender is 
required to choose the right form of personal pronoun ( he vs. she, his vs. her, him vs. her ) 
when personalizing a comment. Instead of clicking a radio button, you can set it with a 
keyboard shortcut: ALT-m for male, ALT-f for female.



This is the count of students in the list. Simply a convenient quick check whether all 
students in the class have been entered.



This area is used to display an error message if you try to add a student without having 
entered. both last and first name.



This is a display of the list of all students in this report card file. You can select a student 
from this list (by clicking on the name) if you need to either edit the student data, e.g. to 
correct the spelling, or delete that student from the list. To de-select a student click on it 
while holding down the Ctrl key.



When you push the Add button, Instant ReportCard checks that last and first name are 
present, then creates a student according to the data in the input fields and adds him/her to 
the list in alphabetical order. All input fields are then cleared and the cursor placed in the 
last name field.
The Add button is usually also the default button, indicated by a thicker outline. The default 
button can be activated by pressing the enter key. This means that you can enter the class 
list solely using the keyboard: typing, tabbing between fields, alt-f/alt-m to select the 
gender, and pressing enter to add to the list, without the need to use the mouse in between.



The Replace button is only enabled if a student is selected in the list. When you push this 
button, Instant ReportCard checks that last and first name are present, then changes the 
student's data according to the data in the input fields.

 These changes will not retroactively change the personalization of comments already in the
student's report card. 
All input fields are then cleared and the cursor placed in the last name field.



The Edit button is only enabled if a student is selected in the list. When you push this 
button, Instant ReportCard retrieves the student's data and places it in the appropriate input
field so that you can make any corrections or additions.

 Instant ReportCard assumes that you pushed the Edit button because you want to modify 
or correct some data of this student. It therefore changes the default button to be Replace 
rather than Add.



The Delete button is only enabled if a student is selected in the list. When you push this 
button, Instant ReportCard deletes that student from the class roster.

 Any comments placed in the student's reportcard will be deleted as well!



The OK button closes the dialog.



The Categories Dialog
The Categories dialog is the place where you you input and maintain the categories for a 
comment library. It consists of one input field, a list and five command buttons. Click on each
field for information about its use.



Enter here the name of the category. The name is required. If you try to add a category 
without giving it a name, Instant ReportCard will alert you with an audible alarm (a beep).



This is a display of the list of all categories in this comment library. You can select a category
from this list (by clicking on the name) if you want to 

edit the category name, e.g. to correct the spelling

delete that category from the list

direct Instant ReportCard where to add a new category:.

 Unlike the students in the class roster, the categories are not sorted alphabetically when 
added to the list. If no category is selected, new categories are added to the end of the list. 
If a category is selected in the list, new categories are added in front of the selected 
category.
To deselect a category, click on it while holding down the Ctrl key.



When you push the Add button, Instant ReportCard checks that the name is present, then 
adds the category to the list. The input field is then cleared and the cursor placed in the 
name field.
The Add button is usually also the default button, indicated by a thicker outline. The default 
button can be activated by pressing the enter key. This means that you can enter categories 
solely using the keyboard: typing the name and pressing enter to add to the list, without the 
need to use the mouse in between.



The Replace button is only enabled if a category is selected in the list. When you push this 
button, Instant ReportCard checks that the name is present, then changes the name of the 
selected category. Any comments associated with this category will be unaffected.
The input field is then cleared and the cursor placed in the name field.



The Edit button is only enabled if a category is selected in the list. When you push this 
button, Instant ReportCard places the category's name in the name field so that you can 
make any corrections.

 Instant ReportCard assumes that you pushed the Edit button because you want to modify 
or correct the name of this category. It therefore changes the default button to be Replace 
rather than Add.



The Delete button is only enabled if a category is selected in the list. When you push this 
button, Instant ReportCard deletes that category from the comment library.

 Any comments associated with this category will be deleted as well!



The OK button closes the dialog.



The Comments Dialog
The Comments dialog is the place where you you input and maintain the comments for a 
comment library. It consists of two input field, a combobox, a list and five command buttons.
Click on each field for information about its use.



Use the combobox to select the category to work on. The list will display the descriptors of 
the comments in the selected category (if any) and new comments will be added to the 
selected category.



Enter here a name/descriptor for the comment. The name is required. If you try to add a 
comment without giving it a name, Instant ReportCard will alert you with an audible alarm (a
beep).
The descriptor is used to identify a comment within the list of comments for a category. For 
your own comments, you can use whatever you like as a descriptor: key words from the 
comment, or number them sequentially, or grade marks (A, B+, ...), or percentages (100%, 
90%, ...).



This is what the descriptors of the comments in the library that comes with Instant 
ReportCard use.



This is where you enter or edit the actual comment. See 



This is a display of the list of all comments in the selected category of this comment library. 
You can select a comment from this list (by clicking on the name) if you want to

edit the comment name, e.g. to correct the spelling

delete that comment from the list

direct Instant ReportCard where to add a new comment

 Unlike the students in the class roster, the comment are not sorted alphabetically when 
added to the list. If no comment is selected, new comments are added to the end of the list. 
If a comment is selected in the list, new comments are added in front of the selected 
comment .
To deselect a comment , click on it while holding down the Ctrl key.



When you push the Add button, Instant ReportCard checks that the descriptor is present 
and a comment has been entered, then adds the comment to the list. The input field is then 
cleared and the cursor placed in the descriptor field.
The Add button is usually also the default button, indicated by a thicker outline. The default 
button can be activated by pressing the enter key. This means that you can enter comments 
solely using the keyboard: typing the descriptor, tabbing to the comment field and typing 
the comment, and pressing enter to add the comment to the list, without the need to use 
the mouse in between.



The Replace button is only enabled if a comment is selected in the list. When you push this 
button, Instant ReportCard checks that the name is present, then changes the name of the 
selected comment .
The descriptor and comment fields are then cleared and the cursor placed in the descriptor 
field.



The Edit button is only enabled if a comment is selected in the list. When you push this 
button, Instant ReportCard places the comment's descriptor and full text into the respective 
fields so that you can make corrections or additions.

 Instant ReportCard assumes that you pushed the Edit button because you want to modify 
or correct the name of this comment. It therefore changes the default button to be Replace 
rather than Add.



The Delete button is only enabled if a comment is selected in the list. When you push this 
button, Instant ReportCard deletes that comment from the comment library.



The OK button closes the dialog.



The Preferences Dialog
The Preferences dialog is the place where you maintain what type of header you want to 
print on each reportcard as well as the odds for the random choice between the common 
name and the personal pronoun for subjectless comment.
It consists of four radio buttons, a scrollbar, two output or feedback fields and a save and 
cancel button. Click on each field for an explanation of its use.



In the header of each student's report card print the last name then the first name, 
separated by a comma.



In the header of each student's report card print the first name followed by the last name.



In the header of each student's report card print the first name followed by the middle initial 
and the last name.



In the header of each student's report card print the first name followed by the all middle 
names and the last name.



Use the scroll bar to set the odds for choosing the subject for a subjectless comment to 
anywhere between 99:1 in favour of the name and 1:99 in favour of the personal pronoun.



This field show the selected odds in favour of choosing the name as subject for a subjectless 
comment.



This field show the selected odds in favour of choosing the personal pronoun as subject for a
subjectless comment.



Click on the Save button to save the settings and exit the dialog



Click on the Cancel button to exit the dialog without saving the settings



The Page Setup Dialog
With the page setup dialog you set the size and location of the header and body area on a 
report card page. This lets you adjust the print output to pre-printed forms. 

It consists of eight input fields. Click on each field for an explanation of its use.



 Enter in this field the distance (margin) from the left edge of the paper to the left edge of 
the area on the page designated for the report card header which will receive the student's 
name.
The measurement is in inches and will be rounded to 1/8"



 Enter in this field the distance (margin) from the right edge of the paper to the right edge of
the area on the page designated for the report card header which will receive the student's 
name.
The measurement is in inches and will be rounded to 1/8"



 Enter in this field the distance (margin) from the top edge of the paper to the top edge of 
the area on the page designated for the report card header which will receive the student's 
name.
The measurement is in inches and will be rounded to 1/8"



 Enter in this field the height of the area on the page designated for the report card header 
which will receive the student's name.
The measurement is in inches and will be rounded to 1/8"



 Enter in this field the distance (margin) from the left edge of the paper to the left edge of 
the area on the page designated for the report card body in which the comments will be 
printed
The measurement is in inches and will be rounded to 1/8"



 Enter in this field the distance (margin) from the right edge of the paper to the right edge of
the area on the page designated for the report card body in which the comments will be 
printed
The measurement is in inches and will be rounded to 1/8"



 Enter in this field the distance (margin) from the top edge of the paper to the top edge of 
the area on the page designated for the report card body in which the comments will be 
printed
This measurement includes the header and should therefore be larger than the sum of the 
top margin and the height of the header or else the header will overlap the body.
The measurement is in inches and will be rounded to 1/8"



 Enter in this field the distance (margin) from the bottom edge of the paper to the bottom 
edge of the area on the page designated for the report card body in which the comments 
will be printed
The measurement is in inches and will be rounded to 1/8"



Click on the Save button to save the settings and exit the dialog



Click on the Cancel button to exit the dialog without saving the settings





Print command (File menu)
Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box
The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify what you want to print:

All Prints the report cards of all students.
Selection

Enables the list with the names of the students, allowing you to select 
individual students. Use the shift- or ctrl- keys for selecting contiguous or 
non-contiguous ranges of students.
Only the report cards of the selected student(s) will be printed.

Copies
Specify the number of copies you want to print.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog
The Printing dialog box is shown during the time that Instant ReportCard is sending output to
the printer.    The page number and student name indicate the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)
Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which each page will be displayed in its printed format.    The print preview toolbar offers you
options to move back and forth through the report cards and initiate a print job. You can 
zoom in and out of the page by clicking on it with the mouse.



Print Preview toolbar
The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next page of the current student's report card.
Prev Page

Preview the previous page of the current student's report card.
Next Student

Preview the report card of the next student in the class roster.
Prev Student

Preview the report card of the previous student in the class roster.
Close

Return from print preview to the editing window.



Print Setup command (File menu)
Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box
The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Check Spelling
If you bought the Instant ReportCard spelling check add-on, three spelling check options 
become available:

Check individual comments in the comment library

Check a single student's report card

Check all report cards in the report card file

The spelling check add-on consists of a DLL and the dictionaries. These pieces must be 
accessible to Instant ReportCard, either in a directory which is in your PATH statement (e.g. 
the windows directory) or in the same directory as Instant ReportCard. It is probably best to 
keep them in the same directory as Instant ReportCard. That is also where they are put by 
the install process.

Apart from the three different ways to invoke the spelling check and the corresponding 
different scopes of the check, the remainder of the spelling check process is the same.



Selecting which dictionary to use
When you use spelling checker, it checks to see what dictionaries are present, and if more 
that one is found, it looks in the SPELMATE.INI file to see if a preference has been set. If no 
such preference is found, it will prompt you to select a dictionary.

 If you check the Use Always Checkbox, the selected dictionary choice is stored in the 
SPELMATE.INI file. From then on, the spelling checker will not prompt for the dictionary 
choice anymore. If you later want to change the dictionary, simply delete the file 
SPELMATE.INI and you will be prompted again the next time you use the spelling checker.
The data dictionary is then loaded and held in memory for maximum speed.



When this option is checked, the choice of dictionary is stored in the file SPELMATE.INI and 
used from then on to determine which dictionary to load without presenting this dialog.



Correcting Mis-spelled Words
When the spelling checker detects a word that it can not find in the main dictionary, nor in 
the private dictionary, it presents the following dialog:

It shows the word in question as well as a list of possible alternatives. The alternatives are 
words from the dictionaries that closely resemble the word in the original text. You have five 
choices to deal with the situation, represented by the 5 buttons in the dialog:

Ignore Accept the word as is and continue with the spelling check. If the word is 
encountered again, this dialog is presented again.

Ignore All Same as Ignore, except that all occurrences of this word are ignored, i.e. if the 
word is encountered again, this dialog is not presented again.

Change Change the word to the one in the "Change To" combo box, then continue with 
the spelling check. You can either select a word from the suggestion list, or type 
the correctly spelled word into the field yourself.
If the word is encountered again, this dialog is presented again.

Add Add the word in question to your private dictionary, then continue with the 
spelling check.
If the word is encountered again, this dialog is not presented again.

Cancel Abort the spelling check.



the word in question



If you click on the Change button, the mis-spelled word will be replaced with the one in this 
edit field. You can either select a word from the suggestion list, or type the correctly spelled 
word into the field yourself.



A list of possible alternatives for the mis-spelled word. The alternatives are words from the 
dictionaries that closely resemble the word in the original text. One of the suggestions is 
pre-selected into the edit field of the combo box.



The dialog title in the caption tells which main dictionary is being used



Accept the word as is and continue with the spelling check.
If the word is encountered again, this dialog is presented again.



Same as Ignore, except that all occurrences of this word are ignored, i.e. if the word is 
encountered again, this dialog is not presented again.



Change the word to the one in the "Change To" combo box, then continue with the spelling 
check. You can either select a word from the suggestion list, or type the correctly spelled 
word into the field yourself.
If the word is encountered again, this dialog is presented again.



Add the word in question to your private dictionary, then continue with the spelling check.
If the word is encountered again, this dialog is not presented again.



Abort the spelling check.



Spelling Check Complete

This message signals the end of the spelling check.



SPELMATE.DLL



an American English dictionary, MAINUS.DIC,
and a British English dictionary, MAINUK.DIC



RPTCARD.EXE



Check individual comments in the comment library
An additional button appears in the "Edit Comments" dialog underneath the field where you 
enter and edit the comments:

Click on it with the mouse to spelling check the current comment. 



Check a student's report card
An additional menu option, "Check Spelling", appear in the "ReportCard" menu. Select it to 
spelling check the report card of the current student.



Check all report cards in the report card file
An additional menu option, "Check Spelling", appear in the "File" menu. Select it to spelling 
check the report cards of all students in the file.




